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NEW QUESTION 1
- (Topic 3)
When a flow runs an action, it generates a runtime value, which stays the same for the duration of the flow. What is the name of this runtime value?

A. Trigger runtime value

B. Sequence runtime value
C. Starting runtime value
D. Data pill runtime value
E. Input runtime value

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/administer/flow-designer/concept/data-population.html

NEW QUESTION 2

- (Topic 3)

A user is complaining that they are seeing a blank page, when they click Create New, from your custom Inventory application. You have confirmed that they can
see the Inventory application, and the Create New module on the application navigator. What could be the cause of this issue?

A. Create New module has a broken link

B. Known intermittent issue with U115

C. User should be using Chrome instead of Explorer for their browser
D. User has read role, but not the write role on the Inventory table

E. User session has timed out

Answer: D

NEW QUESTION 3
- (Topic 3)
Which feature helps to automatically allocate a critical, high priority, service request to the appropriate assignment group or team member?

A. User Policy

B. Ul policy

C. Predictive Intelligence
D. Assignment Rule

Answer: D

NEW QUESTION 4
- (Topic 3)

< —  Catalog Task

Save
Add to Visual Task Board

Metrics Timeline
As: Configure >

Export ).
Cond View >

Create Favorite

Copy URL

Copy sys_id
Show XML
dd History ).

Reload form

Which path would you take to access the table configuration page from a form?

A. The Form Context menu > View > Table
B. The Form Context menu > Configure > Table
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C. The Form Context menu > Configure > Dictionary
D. The Form Context menu > View > Show Table

Answer: B

NEW QUESTION 5
- (Topic 3)
What tool is used to import data from various data sources, and map that data into ServiceMow tables?

A. Import Set
B. Update Set
C. Data Pack
D. Transform Set

Answer: A

NEW QUESTION 6

- (Topic 3)

While testing a Catalog Item for ordering an expensive computer, the mandatory approval is being skipped for requester Bob, Smith, but not for any of the other
requesters. What could explain the issue?

A. There is a business rule, excluding Bob.Smith from any approvals.
B. Bob Smith does not have a delegate set up on his account,

C. The Bob Smith user account, does not have a manager specified.
D. The manager does not have a delegate assigned,

E. Bob Smith is a VIP.

Answer: A

NEW QUESTION 7

- (Topic 3)

While showing a customer their incident form, they ask to change the Priority field title to display their internal terminology PValue. How would you do that? Choose
2 answers

A. Right click on Priority and select Configure Dictionary

B. Right click on Priority and select Configure Display Settings
C. Right click on Priority and select Configure Label

D. Right click on Priority and select Configure Column

Answer: AC

NEW QUESTION 8
- (Topic 3)
When a custom table is created, which access control rules are automatically created? Choose 4 answers

A. delete
B. create
C. execute
D. read

E. update
F. write

Answer: ABDF

NEW QUESTION 9
- (Topic 3)
When building an extended table from a base table, which fields do you need to create? Choose 2 answers

A. The mandatory fields for the base table.

B. The reference fields for the base table.

C. The fields that are not in the base table.

D. The fields that are specific to the extended table.

Answer: CD

NEW QUESTION 10

- (Topic 3)

User records are stored in which table?
A. User [sys_user]

B. User [sn_user]

C. User [u_sys_user]

D. User [s_user]

Answer: A

Explanation:
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Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/administer/navigation-and-ui/concept/c_UserPreferences.htmi

NEW QUESTION 10
- (Topic 3)
What role enables someone to authorize a request, with no other permissions on the platform?

A. Approver [approver-user]

B. Authorize [authorize-user]

C. Reviewer [reviewer_user]

D. Approver Group [approval_group]
E. Verification [verify_user]

Answer: A

NEW QUESTION 11
- (Topic 3)
What section on a task record is used to see the most recent updates made to a record?

A. Related List

B. Activity Stream
C. Audit Log

D. Timeline

Answer: B

NEW QUESTION 16
- (Topic 3)
What section on a task record would you use to see the most recent update made to a record?

A. Timeline
B. Journal
C. Audit Log
D. Activity

Answer: D

NEW QUESTION 21
- (Topic 3)
When using the Data Pill Picker, use which keys to dot-walk (6 fields in other tables?

A. Arrows

B. Plus, Minus

C. Ctrl c, Ctrl

D. Ctrl <, Ctrl >

E. Shift F4, Shit FS

Answer: A

NEW QUESTION 22
- (Topic 3)
The Report Designer contains different sections for configuring your report. Which section is used to specify grouping and calculations to be run against me data?

A. Style

B. Format
C. Data

D. Configure
E. Group by

Answer: D

NEW QUESTION 25

- (Topic 3)

What are examples of Core tables in the ServiceNow platform?
A. Configuration, Connect, Chat

B. Team, Party, Awards

C. User, Task, Incident

D. Work, Caller, Timecard

Answer: C

Explanation:

Reference: https://www.basicoservicenowlearning.in/2019/12/create-table-in- servicenow.html

NEW QUESTION 29
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- (Topic 3)
In what order are Access Controls evaluated?

A. Field-level - mast general to most specific: then Row-level - most specific to most general
B. Table-level - most specific to most general; then Row-level - most specific to most general
C. Table-level - most specific to most general; then Field-level « most specific to mast general
D. Field-level - most specific to most general: then Table-level - most specific to most general

Answer: D

NEW QUESTION 33

- (Topic 3)

A manager wants to view a snapshot of month-end Sales performance data, as compared to Sales targets. In addition, the manager wants to be able to see those
monthly numbers trended over time, and

forecasted into the future. What capability do you suggest for this manager?

A. Scheduled Reports, a custom snapshot table, and a Trend report

B. Scheduled Reports and Excel

C. Scheduled Reports, a custom snapshot table, and a Projection report
D. Performance Analytics

E. Key Performance Indicators

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-now-intelligence/page/use/performance-analytics/concept/c_ForecastingData.html

NEW QUESTION 37

- (Topic 3)

For your implementation, the following tables. are extended fram each ofher:

* Incident table is extended from Task table.

* Super Incident table is extended from Incident table,

In this situation, which table(s) are P arent, Child and Base tables? Choose 5 answers

A. Incident table is a Base table

B. Incident table i

C. a Parent table

D. Incident table is a Child table

E. Super Incident table is a Child table
F. Super Incident table is a Parent table
G. Super Incident table is a Base table
H. Task table is a Base table

I. Task table is a Parent table

J. Task table is a Child table

Answer: BCDGH

NEW QUESTION 41
- (Topic 3)
What are the main components of the Form Design interface? (Choose three.)

A. Field Layout

B. Page Header
C. Field Navigator
D. Field Picker

E. Form Layout

Answer: BCE

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/form-administration/concept/c_FormDesign.html

NEW QUESTION 42

- (Topic 3)

The ServiceNow platform supports a wide variety of plus-and-play application. You can

choose from the included workflow or build your own workflow. Which of following these workflows are included in the platform?

A. Employee Workflows

B. Infrastructure Workflows
C. Federal Workflows

D. Manufacturing Workflows
E. Customer Workflows

F. IT Workflows

Answer: AEF

NEW QUESTION 43
- (Topic 3)
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You have been asked to configure a form so an employee could a tablet and select the

standard accessary options to purchase with it. These standard options are: carrying case, screen cleaner, tablet stand, and screen protector. What approach
would you take?

Choose 3 answers

A. Create Catalog item for the tablet, and on the form, add a check box variable for each accessary option.

B. Create Catalog item for the tablet, and add a variable set to the form, for the accessary options.

C. Create one Catalog item for each: tablet, carrying case, screen cleaner, tablet stand, and screen protector.
D. Create a Records producer, and on the form, add a check box variable for each accessary option.

E. On shopping Cart configuration, select option to show the Add Accessories button.

Answer: ABC

NEW QUESTION 46

- (Topic 3)

A new employee joins the IT deployment and needs to perform work assigned to Network and Hardware groups. How would you set up their access?
Choose 3 answers

A. Add User Account to itll group

B. Add User Account to ACL

C. Add User Account to network group

D. Add User Account to IT Knowledgebase
E. Create User Account

F. Add User Account to Hardware group

Answer: BCF

NEW QUESTION 47
- (Topic 3)
When you set a policy that is applied to all data entered into the platform (Ul, Import Sets, or Web Services), where does this policy run by default?

A. Client
B. Server
C. Browser
D. Network

Answer: B

NEW QUESTION 51
- (Topic 3)
After finishing your work on High Security Settings, what is a possible way to return to normal admin security levels?

A. Use System Administration > Normal Security module
B. Select Normal role

C. Log out and back in

D. Select Global Update Set

E. End impersonation

Answer: A

Explanation:

The System Administration > Normal Security module is the recommended way to return to normal admin security levels after finishing your work on High Security
Settings. This module will automatically disable all high security settings and restore your permissions to their original state.

References:

? ServiceNow Product Documentation: High Security Settings - https://docs.servicenow.com/bundle/vancouver-platform-
security/page/administer/security/reference/high-security-plugin.html

? ServiceNow Community: How to disable High Security Settings - https://www.servicenow.com/community/now-platform-forum/platform-security-everything-you-
need-to-know/m-p/2554570

NEW QUESTION 52
- (Topic 3)
On a Business Rule, the When salting determines at what point the rule executes. What are the options for specifying that timing?

A. Insert, Update, Delet

B. Query

C. 4G} Before, After, Async, Display

D. Prior to, Synchronous, on Update

E. Before, Synchronous, Scheduled Job, View

Answer: B

NEW QUESTION 53

- (Topic 3)

A subject matter expert routinely receives tasks which have been worked by first level support, before receiving the assignment

What could you suggest. to make it easier for the expert to read only the work notes in the Activity log?

A. Click Context menu > Work Notes View
B. Click Personalize icon and select Activity Stream
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C. Right click form header > Form Layout > Add Work Notes Section
D. Click Funnel icon and select only work notes
E. Click Context menu > History

Answer: D

NEW QUESTION 57
- (Topic 3)
Tables may be set up with Many to Many relationships. What is a classic example of a scenario where the tables would have many to many relationships?

A. Requests can contain many items; and Items can be any item from the catalog.

B. Vendors can sell multiple products; and products can be sold by multiple vendors.

C. A Task can trigger many Workflows; and a Workflow can trigger many Tasks

D. A Configuration Item can belong to multiple Classes; and Classes can contain multiple Configuration Items.

Answer: B

NEW QUESTION 58
- (Topic 3)
What capability allows users to create dashboards with widgets to visualize data over time in order to identify areas of improvement?

A. Analytics Reports

B. Performance Analytics
C. Scheduled Reports

D. Reporting

Answer: B

NEW QUESTION 61
- (Topic 3)
What are the three key tables in an enterprise CMDB? Choose 3 answers.

A. omadb_rel_ci
B. sn_emdb

C. sn_emdb_ci
D. Ey omdb

E. sn_emdb_bak
F.omdb _ci

G. emdb_bak

Answer: ADF

NEW QUESTION 63

- (Topic 3)

When adding a related list to a form, you choose the related list from the list callector, What is an example of a related list you might see on the list collector?
Choose 3 answers:

A. Release Phase==Parent
B. Catalog Task->Parent
C. HR Case-=Parent

D. Problem==Parent

E. Outage->Task number

Answer: BCE

NEW QUESTION 66
- (Topic 3)
Which statement correctly describes the differences between a Client Script and a Business Rule?

A. A Client Script executes before a record is loaded and a Business Rule executes after a record is loaded
B. A Client Script executes on the server and a Business Rule executes on the client

C. A Client Script executes on the client and a Business Rule executes on the server

D. A Client Script executes before a record is loaded and a Business Rule executes after a record is updated

Answer: C

Explanation:

Reference: https://community.servicenow.com/community?id=community _question&sys_id=77a80361
db5cdbc01dcaf3231f9619d9#:~:text=The%20major%20difference%20between%200f,delet
ed%2Fqueried%20from%20data%?20base.&text=After%20that%2C%20the%20Client%20s cripts,Client%20scripts%20that%20work%20onSubmit

NEW QUESTION 71

- (Topic 3)

Which feature enables business process owners to organize Flow Designer content into unified and digitized cross-enterprise processes via a digitized task board
Interface?

A. Flow Designer
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B. Process Automation Designer
C. Process Workflow Designer
D. Workflow Editor

Answer: B

NEW QUESTION 75
- (Topic 3)
Which tables are children of the Task table and come with the base system? Choose 3 answers

A. Incident

B. Problem

C. Change Request
D. Config

E. Dictionary

F. cmdb

Answer: ABC

Explanation:

The Task table is a base table in ServiceNow, which means it is not extended from any other table. However, other tables can extend the Task table to inherit its
fields and functionalities. Incident, Problem, and Change Request are all child tables of the Task table, meaning they inherit the fields and functionalities of the
Task table and add their own specific fields and functionalities.

References

? https://docs.servicenow.com/bundle/vancouver-platform-administration/page/administer/task-table/concept/c_TaskTable.html

? https://lwww.servicenow.com/community/now-platform-forum/parent-table-to-get-an-access-to-child-table-column/m-p/1133982

? https://www.servicenow.com/community/developer-forum/difference-between-a-base-class-and-base-table/m-p/1618247

NEW QUESTION 77

- (Topic 3)

An IT user calls the service desk because they need to work on task records. All they can see is Self Service on their homepage when they login to the
ServiceNow instance. What issue could explain this? Choose 2 answers

A. Their user account failed LDAP authentication

B. Their user account is not logged in properly

C. Their user account was not approved by their manager

D. Their user account does not have itil role

E. Their user account does not belong to any groups, which contain the itil role

Answer: AC

NEW QUESTION 79
- (Topic 3)
Farm a form, what would you click, to modify the order of the fields on the form? Choose 2 answers

A. Context Menu > Configure > Form Layout

B. Context Menu > Form > Layout

C. Right click on header > Configure > Form Design
D. Context Menu > Configure > Form Designer

E. Right click on header > Configure > UX Dashboard

Answer: AC

NEW QUESTION 80

- (Topic 3)

You have heard about a new application released by SericeNow, You want to try it out, to- see if it might be useful for your company's ServiceNow implementation.
What would be the best way to get hands-on experience with the new application?

A. Check the latest release notes at docs.servicenow.com.

B. Activate the application plug in, on your personal dev instance.

C. Search the wiki for the sales demo request form,

D. Activate the application plug in, on your company's production instance.

Answer: B

NEW QUESTION 81

- (Topic 3)

A customer wants to be able to identify and track components of their infrastructure that support their ecommerce service. What ServiceNow products could
support this

requirement? Choose 3 answers

A. Performance Analytics

B. Configuration Management (CMDB)
C. Financial Management

D. Discovery

E. Service Mapping

Answer: BDE
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Explanation:

Configuration Management (CMDB) is a product that allows users to identify and track components of their infrastructure, such as servers, applications,
databases, networks, and devices, and their relationshipsl. CMDB provides a single source of truth for IT assets and services, and supports IT service

management processesl.

Discovery is a product that automatically scans the network and populates the CMDB with the discovered infrastructure components and their attributes2.

Discovery uses probes, sensors, and patterns to identify and classify IT assets, and updates the CMDB with any changes2.

Service Mapping is a product that creates a top-down view of the infrastructure components that support a specific business service, such as ecommerce3.
Service Mapping uses discovery data and application traffic analysis to map the dependencies and relationships between IT assets and services, and displays

them in a graphical interface3. References

? Configuration Management Database (CMDB) - ServiceNow1
? Discovery - ServiceNow?2

? Service Mapping - ServiceNow3

NEW QUESTION 86
- (Topic 3)
Which type of scripts run in the browser?

A. Policies and Client Scripts
B. Access Contral Scripts

C. script Include Scripts

D. Business Rule Scripts

Answer: A

NEW QUESTION 90
- (Topic 3)
What icon do you use to change the icon and color on a Favorite’?

A. Star

B. Triangle
C. Pencil
D. Clock

Answer: C

NEW QUESTION 94
- (Topic 3)

What is the best practice related to using the Default Update Set for moving customizations between instances?

A. Merge Default update sets before moving between instances
B. Submit Default update set to application repository

C. You should not use the Default Update sets for moving between instances
D. Keep Default update set to maximum of 20 records, for troubleshooting purposes

Answer: C

Explanation:

Reference: https://docs.servicenow.com/bundle/rome-application-development/page/build/system-update-sets/reference/default-update-sets.html

NEW QUESTION 97
- (Topic 3)

The wait time for end users is based on the round-trip between the client and the server. What activities are included in the round-trips?

A. Request + Response
B. Save + Update

C. Write + Read

D. Submit + Query

E. Insert + Verify

Answer: A

Explanation:

Reference: https://docs.servicenow.com/bundle/rome-application-development/page/script/client-scripts/concept/client-script-best-practices.html

NEW QUESTION 101
- (Topic 3)

ServiceNow contains over 25 different report types. What are some of the types? Choose 5 answers

A. Pie

B. Speedometer
C. Odometer

D. Thermometer
E. Horizontal Bar
F. Semi-Donut
G. Donut

Answer: ABEFG

Your Partner of IT Exam

visit - https://www.exambible.com



We recommend you to try the PREMIUM CSA Dumps From Exambible
exam blb|@ https://www.exambible.com/CSA-exam/ (371 Q&AS)

NEW QUESTION 103
- (Topic 3)
Many actions are included with flow designer, what are some frequently used core actions? Choose 4 answers.

A. Wait for Condition
B. Ask for Approval
C. Create Record

D. Wait for Match

E. Look for Update
F. Look Up Record

Answer: BCDF

NEW QUESTION 104
- (Topic 3)
When managing tags, you can adjust who is able to see iL What are the visibility options? Choose 3 answers

A. Admins

B. Everyone

C. Groups and Users

D. Roles and Permissions
E. Me

Answer: BCE

NEW QUESTION 106

- (Topic 3)

The testing team needs to be able to perform activities in the test instance, as though they

are a member of the Service Desk group. What role would they need to be able to switch between user accounts, without logging out and back in?

A. service_desk
B. impersonator
C. admin

D. incognito

Answer: B

Explanation:

The impersonator role allows a user to switch to another user account and act as that user without logging out and back inl. This can be useful for testing
purposes or for providing support to other users2.

ReferencesIimpersonate a userRoles and permissions

NEW QUESTION 110

- (Topic 3)

Access Control rules are applied to a specific table, like the Incident table. What is the object name for a rule that applies to the entire Incident table (all rows and
fields)?

A. incident .*
B. incident.all
C. incident .!
D. incident.None

Answer: A

Explanation:

The object name for a rule that applies to the entire Incident table is incident

*, which means any field on the incident table. The other options are not valid object names for access control rules.
ReferencesAccess control list rulesAccess Control List in ServiceNowAccess Controls

NEW QUESTION 114

- (Topic 3)

Which ServiceNow utility provides a modern interactive graphical interface to visualize
configuration items and their relationship?

A. CSDM Schema

B. Business Service Map
C. Dependency View

D. CI Class Map

Answer: D

NEW QUESTION 116
- (Topic 3)
What type of field has a drop down list, from which you can pick from pre-defined options?

A. Choice

B. Picker
C. Drop down
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D. Option
Answer: A

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0538947

NEW QUESTION 118
- (Topic 3)
Which element is used to track items not saved with a field, in a record?

A. Sidebar

B. List Editor

C. Activity formatter
D. Dictionary

Answer: C

Explanation:
The activity formatter provides an easy way to track items not saved with a field in the record, such as journal fields like comments and work notes1.
ReferencesFormatters and Related Lists

NEW QUESTION 122
- (Topic 3)
What is the most common role that has access to almost all platform features, functions, and data?

A. Security Admin [security_admin]
B. Sys Admin [sys_admin]

C. Admin [sn_admin]

D. System Administrator [admin]
E. Base Admin [base_admin]

Answer: C

Explanation:
Reference: https://developer.servicenow.com/dev.do#!/guides/quebec/now-platform/glossary/developer-glossary

NEW QUESTION 125
- (Topic 3)
Which data consistency settings can be achieved using Ul Policy? Choose 3 answers

A. Setting fields to accept the data with ‘n’ number of characters
B. Setting fields hidden

C. Setting fields to accept the data in an expected format

D. Settings fields read-only

E. Setting fields mandatory

Answer: BDE

NEW QUESTION 127
- (Topic 3)
What is used to determine user access to knowledge bases or a knowledge article?

A. sn_kb_read, sn_article_read
B. Privacy Settings

C. Read Access Flag

D. User Criteria

Answer: D
Explanation:

Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/concept/user-access-knowledge.html

NEW QUESTION 131

- (Topic 3)

On the knowledge base record, which tab would you use to define which users are able to write articles to the knowledge base?
A. Can Read

B. Can Write

C. Can Contribute

D. Can Author

E. Cannot Author

Answer: C

NEW QUESTION 136
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- (Topic 3)
What is the definition of a group?

A. An escalation pod

B. A department

C. A collection of users

D. A collection of subject matter experts
E. A team of users

Answer: C

NEW QUESTION 137
- (Topic 3)
Which testing framework is used to test ServerNew Applications?

A. Selenium

B. Test Driven Framework (TDF)

C. Junit

D. Automated test Framework (ATF)

Answer: D

NEW QUESTION 140
- (Topic 2)
When creating a global custom table named “abc”, what is the table name that is automatically assigned by the platform?

A. snc_abc
B. abc
C.u_abc
D. sys_abc

Answer: C

NEW QUESTION 144

- (Topic 2)

Two departments (HR Onboarding and Facilities) have come to you, asking for a way for employees to request event room set up services. The requirements are
the same for the form and the task routing to the Facilities’ assignment group.

For HR, the item will be used primarily for the Onboarding coordinators, for employee orientation sessions.

For Facilities, the item will be used for anyone in the company who needs room set up services.

However, both departments have their own service catalogs. What do you do, to support these requirements?

A. Create one Catalog Item for HR Event Room Set Up and one for Facilities Event Room Set Up; then publish each to the appropriate Catalog.
B. Create one Catalog Item for Event Room Set Up; then publish to both Catalogs.

C. Create one Catalog Item for Event Room Set Up; then publish to the Parent Catalog, which is accessible to both HR and Facilities.

D. Create one Catalog Item for Event Room Set Up; then use ACLs to control access.

Answer: C

NEW QUESTION 148
- (Topic 2)
What feature can track the amount of time that a task has been open, to ensure that tasks are completed within an allotted time?

A. Task Escalation Clock

B. Service Level Agreements
C. Inactivity Monitor

D. Response Time Clock

E. Business Time Remaining

Answer: B

Explanation:

Reference: https://docs.servicenow.com/bundle/rome-platform- administration/page/administer/task-
table/reference/r_ToolsForDrivingTasks.html#:~:text=Service%20level%20agreements%20
can%?20track,completed%?20within%20an%20allotted%20time.&text=Inactivity%20monitors
%20ensure%20that%20tasks,a%20predefined%20period%200f%20time

NEW QUESTION 151
- (Topic 2)
From a form, what would you click to add additional fields to the form? (Choose two.)

A. Context Menu > Form > Layout

B. Context Menu > Configure > Form Layout

C. Context Menu > Configure > Form Design

D. Right click on header > Add > Field

E. Context Menu > Form > Designer

F. Right click on header > Configure > UX Dashboard

Answer: BD
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Explanation:
Reference: https://docs.servicenow.com/bundle/rome-it-service-management/page/product/change-management/task/t_CreateCustomField.html

NEW QUESTION 156
- (Topic 2)
When you need to orchestrate business processes across services with little technical user knowledge, which utility would you use?

A. Flow Manager

B. Flow Designer

C. Flow Editor

D. Workflow Editor

E. Workflow Designer

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/orchestration/reference/r-orchestration-introduction.html

NEW QUESTION 160
- (Topic 2)
How is a group defined in ServiceNow?

A. A group is one record stored in the Group Type [sys_user_group_type] table
B. A group is one record stored in the Group [sys_user_group] table

C. A group defines a set of users that share the same location

D. A group defines a set of users that share the same job title

Answer: B

NEW QUESTION 165
- (Topic 2)
Which module would you use to create a new automation of business logic such as approvals, tasks, and notifications?

A. Process Automation > Flow Designer

B. Process Automation > Flow Administration
C. Process Automation > Workflow Editor

D. Process Automation > Process Flow

E. Process Automation > Active Flows

Answer: A

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/administer/process-automation-designer/concept/getting-started-process-
automation.html

NEW QUESTION 168
- (Topic 2)
What is a no-code approach to control the mandatory or read-only state of a form field?

A. Ul Action

B. Client Script
C. Ul Script

D. Ul Rule

E. Ul Policy

Answer: E
Explanation:

Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/field-administration/concept/c_DataPolicy.html

NEW QUESTION 171

- (Topic 2)

Your company is giving all first line workers a special T-shirt as a recognition for their hard work. Management team wants a way for employees to order the T-
shirt, with the ability to specify the preferred size and color. How would you ensure that only first line workers (non- managers) can submit the order?

A. Create Record Producer and use the Available For list to specify First Line [sn_first_line] role
B. Create Catalog Item and use the Not Available list to specify the Manager Group

C. Create Catalog Item and use the Available For list to specify ITIL [itil] role

D. Create Order Guide and use the User Criteria list to specify First Line [sn_first_line] role
Answer: B

Explanation:

Reference: https://docs.servicenow.com/bundle/orlando-it-service-management/page/product/service-catalog-management/task/t_AppUserCrititemsCat.html

NEW QUESTION 175
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- (Topic 2)
When using the Performance Analytics application in the Now Platform, what kind of KPI signals are used to make decisions that statistically support long term
workflow stability?

A. Long-term signals
B. Non-signals

C. Anti-signals

D. Stability signals

Answer: C

NEW QUESTION 178
- (Topic 2)
What Is the purpose of the Fitter navigator In the Application Navigator?

A. Filter applications in order of use

B. Quickly navigate to applications and modules
C. Collapse and expand applications

D. List applications In order of Top Requests

Answer: C

NEW QUESTION 183
- (Topic 2)
Which plugin needs to be activated in order to translate the content of a catalog item to multiple languages?

A. Localization Framework plugin (com.glide.localization_framework)

B. Translation Framework plugin (com.glide.translation_framework)

C. Multiple Language Framework plugin (com.glide.multiple.language_framework)
D. Language Al Framework plugin (com .g | id

E. language.ai _framework)

Answer: A

NEW QUESTION 185
- (Topic 2)
What type of field allows you to look up values from one other table?

A. Reference
B. Verity

C. Options
D. Selections
E. Dot walk
F. Lookup

Answer: A

Explanation:
Reference: https://support.microsoft.com/en-us/office/create-or-delete-a-lookup-field-87e84cbd-d60c-4473-8a98-
3e391c42f239#:~:text=A%20lookup%?20field%20can%20display,order%20in%20the%200rders%20table

NEW QUESTION 190
- (Topic 2)
When a user reports that they are not able to see modules on the application navigator, what can you do, to see what modules are visible to them?

A. Look up their password, so you can login with their account
B. Initiate a Connect Chat session

C. Install the Bomgar plug-in

D. Impersonate the user

E. Launch a NowChat window

Answer: B

NEW QUESTION 192

- (Topic 2)

When impersonating a user for testing purposes, what is the best way to return the instance, logged in with your user account?
A. Turn your computer off and on again

B. Clear browser cache

C. End Impersonation

D. Log out and back in

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/users-and-groups/concept/c_ImpersonateAUser.html
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NEW QUESTION 193
- (Topic 2)
When moving multiple update sets at one time, what might you do to facilitate the move?

A. Batch
B. Verify
C. Test

D. Preview

Answer: A

Explanation:
Reference: https://www.servicenowelite.com/blog/2016/8/7/update-sets

NEW QUESTION 197
- (Topic 2)
What needs to be specified, when creating a Business Rule? (Choose four.)

A. Ul action

B. Table

C. Fields to update

D. Who can run

E. Script to run

F. Application scope
G. Update set

H. Timing

I. Condition to evaluate

Answer: ABEF

Explanation:

Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/list-administration/task/t_EditingAUIAction.html

NEW QUESTION 200
- (Topic 2)

The ServiceNow Virtual Agent provides assistance within a messaging interface. Which capability allows end users to configure virtual Agent to intercept and help

resolve submitted incidents?

A. Incident Auto-Resolution
B. Ticket Resolver

C. Virtual Agent Helper

D. Web Intelligence

Answer: A
NEW QUESTION 205

- (Topic 2)
A change request has been approved and assigned to you as the system administrator to

change the Incident number prefix from the default of "INC" to the company standard IN." What are the next steps to be taken"

A. Go to the Number Maintenance application and change the prefix to "IN" for incident
B. Create a Business Rule that modifies the prefix before the Insert operation

C. The prefix of an incident cannot be changed because it is a built-in feature

D. Submit a Change Request to ServiceNow Technical Support

Answer: A

NEW QUESTION 208
- (Topic 2)
What is a Notification?

A. A new Knowledge article created by a Business Rule

B. A tool for alerting users that events that concern them have occurred
C. A message through Connect related to a Change Request

D. An email file attachment

Answer: B

NEW QUESTION 213

- (Topic 2)

What are the steps to retrieve an Update Set?

A. Verify Update Set is Complete, Retrieve, Preview, Apply
B. Verify Update Set is Complete, Test Connection, Apply
C. Verify Update Set is Complete, Test Connection, Commit

D. Verify Update Set is Complete, Retrieve, Preview, Commit

Answer:
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C

NEW QUESTION 215
- (Topic 2)
The ServiceNow platform includes which types of interfaces? (Choose three.)

A. Now Mobile Apps

B. Agent Control Center

C. Back Office Dashboard

D. Service Portals

E. Now Platform® User Interfaces
F. Field Service Taskboard

Answer: ADE

Explanation:
A. https://docs.servicenow.com/bundle/rome-mobile/page/administer/tablet-mobile-ui/concept/mobile-config-navigation.html D and E.
https://www.servicenow.com/products/service-portal.html

NEW QUESTION 220

- (Topic 2)

An IT manager is responsible for the Network and Hardware assignment groups, each group contains 5 team members. These team members are working on
many tasks, but the manager cannot see any tasks on the Service Desk > My Groups Work list. What could explain this?

= Tasks m Search Number v Search

? All > Assignment group = Network.or. Assignment group = Hardware

A. The Service Desk > My Groups Work list shows active work tasks that are not yet assigned.
B. The manager does not have the itil role.

C. The manager is not a member of the Service Desk group.

D. The manager is not a member of the Network and Hardware groups.

E. The Assignment Group manager field is empty.

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/users-and-groups/task/t_CreateAGroup.html

NEW QUESTION 222
- (Topic 2)
Which fields can be configured in reporting to perform arithmetic, coalesce, concatenation, and length?

A. Sourcing fields

B. Function fields

C. Computational fields
D. Calculation fields

Answer: B

NEW QUESTION 225

- (Topic 2)

A new Service Desk employee in Latin America complains that the create dates and times are incorrect on their Incident list. What would you suggest to fix this
issue?

A. Have them clear their cache.

B. Have them use the gear icon to set the employee’s time zone.
C. Recommend they use Chrome, instead of Explorer.

D. Use the system properties to correct the instance’s time zone.
E. Have them correct the time zone on their computer.

Answer: E

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0659171

NEW QUESTION 229
- (Topic 2)
Which of the following steps can be used to import new data into ServiceNow from a spreadsheet?

A. Select Data Source, Schedule Transform

B. Load Data, Create Transform Map, Run Transform

C. Define Data Source, Select Transform Map, Run Transform
D. Select Import Set, Select Transform Map, Run Transform

Your Partner of IT Exam visit - https://www.exambible.com



We recommend you to try the PREMIUM CSA Dumps From Exambible
exam blb|@ https://www.exambible.com/CSA-exam/ (371 Q&AS)

Answer: D

NEW QUESTION 234
- (Topic 2)
When designing a flow, how do you reference data from a record, in that flow?

A. Drag the table icon onto the flow definition

B. Use the condition builder to specify the desired values
C. Specify the source table on the data pill related list

D. Drag the data pill onto the flow definition

E. Add the table reference using the slush bucket

Answer: D

Explanation:
Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/paris/citizen_developer/app_store_learnv2_flowdesigner_paris_using_flow_variables

NEW QUESTION 238
- (Topic 2)
Access Control rules may provide access security for which of the following database objects?

A. For a specific role, group, or user

B. For a specific row, column, or table

C. For specific groups

D. For a specific CMDB Configuration item

Answer: D

NEW QUESTION 241
- (Topic 2)
Which ServiceNow capability provides assistance to help users obtain information, make decisions, and perform common work tasks via a messaging interface?

A. Agent Workspace
B. Chat bot

C. Virtual Agent

D. Knowledge Chat
E. Now Support

Answer: C

NEW QUESTION 244
- (Topic 2)
Which of the following protects applications by identifying and restricting access to available files and data?

A. Application Configuration
B. Verbose Log

C. Access Control Rules

D. Application Scope

Answer: D

NEW QUESTION 249
- (Topic 2)
What is the purpose of a Data Policy?

A. Data Policies enforce security

B. Data Policies standardize data in Update Sets
C. Data Policies enforce data consistency

D. Data Policies apply to lists to standard data

Answer: C

NEW QUESTION 254

- (Topic 1)

database live at the Data Center.

A. True
B. False

Answer: A

NEW QUESTION 255
- (Topic 1)
When searching using the App Navigator search field, what can be returned? (Choose four.)
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A. Names of Applications and Modules
B. Names of Modules

C. Names of Applications

D. Favorites

E. History Records

F. Titles of Dashboard Gauges

Answer: ABCD

NEW QUESTION 260
- (Topic 2)
What is a role in ServiceNow?

A. Arole is one record m the Role [sys_user_role] table
B. Arole is one record in the Role luser_sys_role] table
C. Arole is a persona used In Live Feed Chat

D. Arole Is a set of modules for a particular application

Answer: A

NEW QUESTION 261
- (Topic 2)
What import utility do you use when the field names on the import set match the name of the fields on the Target table?

A. Schema Mapping

B. Automatic Mapping
C. Mapping Assist

D. Mapping Dashboard

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/script/server-scripting/concept/c_MappingOptions.html

NEW QUESTION 265
- (Topic 1)
The baseline Service Catalog homepage contains links to which of the following components?

A. Record Producers, Order Guides, and Catalog Items
B. Order Guides, Iltem Variables, and Workflows
C. Order Guides, Catalog Items, and Workflows
D. Record Producers, Order Guides, and Item Variables

Answer: A

NEW QUESTION 268
- (Topic 1)
What information does the System Dictionary contain?

A. The human-readable labels and language settings
B. The definition for each table and column

C. The information on how tables relate to each other
D. The language dictionary used for spell checking

Answer: B

NEW QUESTION 269
- (Topic 1)
There are common types of Interfaces (Numeric Value) 6: There are six common types of interfaces

A. Homepage: Consists of navigational elements, functional controls, and platform information.

B. List: Display records from a data table, as well as allow you to edit the record information using the List Editor functionally.
C. Form: Data is entered into ServiceNow through forms

D. Dashboard: Enable you to display multiple performance analytics, reporting and other widgets on a single screen.

E. Maps: Display ServiceNow data graphically on a Google map

F. Timelines: Used to track tasks or projects

Answer: C

NEW QUESTION 274
- (Topic 1)
What are the two pathways to view feedback left on a published article?

A. Knowledge > articles > My Flagged

B. Knowledge base > my knowledge > flagged articles
C. Knowledge > My articles > Flagged

D. Knowledge > articles > published
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Answer: AD

NEW QUESTION 277
- (Topic 1)
What are the main Ul component(s) of the ServiceNow Platform?

A. Banner Navigator

B. Banner Frame

C. Application Frame

D. Application Navigator
E. Content Menu

F. Content Frame

Answer: BDF

NEW QUESTION 281
- (Topic 1)
Which of the following statement describes the purpose of an Order Guide?

A. Order Guides restrict the number of items in an order to only one item per request

B. Order Guide provide a list of guidelines for Administrators on how to set up item variables
C. Order Guide provide the ability to order multiple, related items as one request

D. Order Guides take the user directly to the checkout without prompting for information

Answer: C

NEW QUESTION 283
- (Topic 1)
Which one of the following statements describes the purpose of a Service Catalog workflow?

A. A Service Catalog workflow generates three basic components: item variable types, tasks, and approvals

B. Although a Service Catalog workflow cannot send notifications, the workflow drives complex fulfillment processes

C. A Service Catalog workflow is used to drive complex fulfilment processes and sends notifications to defined users or groups
D. A Service Catalog workflow generates three basic components: item variable types, tasks, and notifications

Answer: C

NEW QUESTION 284
- (Topic 1)
Which of the following statements is true when a new table is created by extending another table?

A. The new table archives the parent table and assumed its roles in the database
B. The new table inherits all of the Business Rules, Client Scripts, and Ul Policies of the parent table, but none of the existing fields
C. The new table inherits all of the fields of the parent table and can also contain new fields unique to itself

D. The new table inherits all of the fields, but does not inherit Access Control rules, Client Scripts, and Ul Policies of the parent table

Answer: C

NEW QUESTION 289
- (Topic 1)
Which one of the following statements is true about Column Context Menus?

A. It displays actions such as creating quick reports, configuring the list, and exporting data
B. It displays actions related to filtering options, assigning tags, and search

C. It displays actions related to viewing and filtering the entire list

D. It displays actions such as view form, view related task, and add relationship

Answer: A

NEW QUESTION 290
- (Topic 1)

What is generated from the Service Catalog once a user places an order for an item or service?
A. A change request
B. An Order Guide

C. Arequest

D. An SLA

Answer: C

NEW QUESTION 292
- (Topic 1)

Which group of permissions is used to control Application and Module access?

A. Access Control Rules
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B. Ul Policies
C. Roles
D. Assignment Rules

Answer: C

NEW QUESTION 296
- (Topic 1)

What is the path an Administrator could take to view the fulfillment stage task list for an order placed by a user?

A. RITM (Number)>REQ (Number)>PROCUREMENT (Number)
B. REQ (Number)>RITM (Number)>PROCUREMENT (Number)
C. REQ (Number)>RITM (Number)>TASK (Number)

D. FULFILLMENT (Number)>RITM (Number)>TASK (Number)

Answer: C

NEW QUESTION 298
- (Topic 1)
Configuration will not affect what others see on their forms.

A. True
B. False

Answer: B

NEW QUESTION 301
- (Topic 1)
What is the purpose of flagging an article in a knowledge base?

A. To mark an article to read later.
B. Allow a user to submit feedback about an article
C. Reporting an error

Answer: B

NEW QUESTION 305
- (Topic 1)
The display sequence is controlled in a Service Catalog Item using which of the following?

A. The Default Value field in the Catalog Item form
B. The Sequence field in the Catalog Item form

C. The Order field in the Variable form

D. The Choice field in the Variable form

Answer: C

NEW QUESTION 309
- (Topic 1)
What displays a set of records from a table?

A. View

B. Dashboard
C. Panel

D. List

Answer: D

NEW QUESTION 313
- (Topic 1)

What is the name of the conversational bot platform that provides assistance to help users obtain information, make decisions, and perform common tasks?

A. Agent

B. live Feed

C. Virtual Agent
D. Connect Chat

Answer: C

NEW QUESTION 315

- (Topic 1)

Which of the following is used to initiate a flow?

A. A Trigger
B. Core Action
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C. A spoke
D. An Event

Answer: A

NEW QUESTION 319
- (Topic 1)
What is a Dictionary Override?

A. A Dictionary Override is an incoming customer update in an Update Set which applies to the same objects as a newer local customer update
B. A Dictionary Override is the addition, modification, or removal of anything that could have an effect on IT services

C. A Dictionary Override is a task within a workflow that requests an action before the workflow can continue

D. A Dictionary Override sets field properties in extended tables

Answer: D

NEW QUESTION 323
- (Topic 1)
What is a Record Producer?

A. A Record Producer is a type of Catalog Item that is used for Requests, not Services

B. A Record Producer creates user records

C. A Record Producer is a type of Catalog Item that provides easy ordering by bundling requests

D. A Record Producer is a type of a Catalog Item that allows users to create task-based records from the Service Catalog

Answer: D

NEW QUESTION 325
- (Topic 1)
Which type of interface enables you to display multiple performance analytics, reporting and other widgets on a single screen?

A. Form

B. List

C. Dashboard
D. Timeline

Answer: C

NEW QUESTION 329
- (Topic 1)
Which technique is used to get information from a series of referenced fields from different tables?

A. Table-Walking
B. Sys_ID Pulling
C. Dot-Walking

D. Record-Hopping

Answer: C

NEW QUESTION 330
- (Topic 1)
Which of the following is true of Service Catalog Items in relation to the Service Catalog?

A. They run behind the scenes.
B. They are the building blocks.
C. They are optional.

D. They provide options.

Answer: B

NEW QUESTION 334
- (Topic 1)
Which of the following allows a user to edit field values in a list without opening the form?

A. Data Editor

B. Edit Menu

C. List Editor

D. Form Designer

Answer: C

NEW QUESTION 335
- (Topic 1)
Knowledge Base Search results can be sorted by which of the following? (Choose three.)
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A. Most recent update
B. Popularity

C. Relevancy

D. Manager assignment
E. Number of views

Answer: ACE

NEW QUESTION 336
- (Topic 1)
Which three Variable Types can be added to a Service Catalog Item?

A. True/False, Multiple Choice, and Ordered

B. True/False, Checkbox, and Number List

C. Number List, Single Line Text, and Reference
D. Multiple Choice, Select Box, and Checkbox

Answer: D

NEW QUESTION 338
- (Topic 1)
Where can Admins check which release is running on an ServiceNow instance?

A. Memory Stats module
B. Stats module

C. System.upgraded table
D. Transactions log

Answer: B

NEW QUESTION 340
- (Topic 1)
Buttons, form links, and context menu items are all examples of what type of functionality?

A. Business Rule
B. Ul Action

C. Client Script
D. Ul Policy

Answer: B

NEW QUESTION 345
- (Topic 1)
What is the function of user impersonation?

A. Testing and visibility

B. Activate verbose logging

C. View custom perspectives

D. Unlock Application master list

Answer: A

NEW QUESTION 348
- (Topic 1)
Which statement is true about business rules?

A. A business rule must run before a database action occurs

B. A business rule can be a piece of Javascript

C. A business rule must not run before a database action occurs
D. A business rule monitors fields on a form

Answer: B

NEW QUESTION 349

- (Topic 1)

Which one of the following statements describes a characteristic of role assignment?

A. Roles can contain other roles, when you are assigned a role, you inherit all the roles within that role
B. Users can click on the Personalize Role feature to try different roles

C. Arole is granted to a user by the System Administrator

D. Each user has a role in the ServiceNow platform

Answer: A

NEW QUESTION 354
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- (Topic 1)
For Administrators creating new Service Catalog items, what is a characteristic they should know about Service Catalog variables?

A. Service Catalog variables can only be used in Record Producers
B. Service Catalog variables can only be used in Order Guides

C. Service Catalog variables cannot affect the order price

D. Service Catalog variables are global by default

Answer: D

NEW QUESTION 359
- (Topic 1)
Which type of tables may be extended by other tables, but do not extend another table?

A. Base Tables

B. Core Tables

C. Extended Tables
D. Custom Tables

Answer: A

NEW QUESTION 364
- (Topic 1)
Which one statement correctly describes Access Control rule evaluation?

A. Rules are evaluated using role

B. The role with the most permissions evaluates the rules first

C. If more than one rule applies to a row, the older rule is evaluated first

D. If a row level rule and a field level rule exist, both rules must be true before an operation is allowed
E. Rules are evaluated from the general to the specific, so a table rule must be active to continue

Answer: D

NEW QUESTION 368
FILL IN THE BLANK - (Topic 1)
FILL IN THE BLANK
is a computer program running as a service; a physical computer dedicated to running one or more services, or a system running a database.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Server

NEW QUESTION 369
- (Topic 1)
What is the platform name for the User table?

A. u_users
B. sys_users
C. x_users
D. sys_user

Answer: D

NEW QUESTION 371
- (Topic 1)
What are the three components of a filter condition?

A. Table
B. Value
C. Field
D. Operator

Answer: BCD

NEW QUESTION 374
- (Topic 3)
A task worker asks how they can monitor any updates occurring to recands assigned to him, like responses from customers, What do you suggest?

A. Open an Agent workspace tab for each record he wants to monitor

B. Select Service Desk > My Work Dashboard

C. Click on the eyeglass icon t

D. expand the Monitor frame

E. On My Work list, select the Activity Stream icon to show a frame with live updates
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Answer: D

NEW QUESTION 377
- (Topic 3)
What would you do, on a list, if you wanted to show the records in groups, based on the column category? (Choose two.)

A. On list Context Menu, select Group By > Category

B. On the Filter Menu, select Group By > Category

C. Click Group On icon, select Category

D. On Navigator Filter, type tablename.group.category and press enter

E. On the Category column title, click Context menu > Group By Category

Answer: AE

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-lists/concept/c_GroupedLists.html

NEW QUESTION 378
- (Topic 3)
A Role is defined as what?

A. A collection of permissions
B. A set of user access policies
C. A Persona in a workflow

D. A set of access control rules

Answer: A

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/roles/concept/c_Roles.html

NEW QUESTION 380

- (Topic 3)

What contains the configuration changes made in an instance (i.e. changes in a form) and
helps to implement the changes from the Dev environment to another environment?

A. Update sets

B. Transform maps

C. System dictionaries
D. Import sets

Answer: A

Explanation:

Update sets are the configuration changes made in an instance, such as changes in a form, that can be exported from one instance and imported into another.
This helps to implement the changes from the Dev environment to another environment, such as Test or Prod. Update sets capture the changes made to system
properties, Ul actions, business rules, workflows, and other customizations.

Referencesl: Get started with update sets - ServiceNow - Now Support2: Product Documentation | ServiceNow3: Update Set in ServiceNow, Captured, Non-
Captured, Commit, Import ...4: In depth Concepts Update Set in ServiceNow - Basico ServiceNow Learning5: Retrieving and committing update sets between
different ... - ServiceNow

NEW QUESTION 381
- (Topic 3)
What feature allows, you to limit who is able to contribute or read knowledge within a knowledge base?

A. Categories
B. Roles

C. User Criteria
D. Groups

Answer: C

NEW QUESTION 386
- (Topic 3)
Which helps to visualize configuration items and their relationships?

A. Transform Map

B. Schema Map

C. Tables

D. Flow Design

E. Dependency View

Answer: E
Explanation:

The Dependency View provides a visual representation of the relationships between configuration items (CIs) in ServiceNow. It allows you to see how Cls are
connected and how changes to one Cl may impact others.
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References:

? ServiceNow Product Documentation: Configuration item relationships in the CMDB

- https://docs.servicenow.com/bundle/vancouver-servicenow- platform/page/product/configuration-management/concept/c_CIRelationships.html
? ServiceNow Community: How to display dependencies for Cls in the Dependency

View - https://www.servicenow.com/community/service-management-forum/load- a-specific-dependency-view-map/m-p/410421

NEW QUESTION 390

- (Topic 3)

What are examples of Ul Actions relating to forms?
Choose 3 answers

A. Form Context Menu
B. Form View

C. Form Buttons

D. Form Links.

E. Form Columns

Answer: ACD

NEW QUESTION 392
- (Topic 3)
While on an Incident record, how would you add a Tag for "Special Handling" to the record?

A. Click on the More options (.,.) icon, click Add Tag, type Special Handling, press enter
B. On the Special Handling field, check the box

C. On the Tag field, select Special Handling from the choice list

D. Click on the Context menu, select Add Tag, type Special Handling, press enter

Answer: A

NEW QUESTION 396
- (Topic 3)
Which ServiceNow capability allows you to provide knowledge articles, via a conversational messaging interface?

A. Agent Assist

B. Virtual Agent

C. Now Messenger
D. Connect Agent

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-release-notes/page/release-notes/analytics-intelligence-reporting/virtual-agent-rn.html

NEW QUESTION 401
- (Topic 3)
When creating a new notification, what must you define? Choose 3 answers

A. What is the content of the notification

B. The associated knowledge base

C. Under what conditions is the notification sent
D. Who receives the notification

E. Settings for handling inactive user accounts

Answer: ACD

NEW QUESTION 402

- (Topic 3)

Roles can inherit permissions from other roles. Which role inherits all of the permissions of the catalog role and the user_critena_admm role plus has permissions
to create Items and Services?

A. item Admin [sn_item_admin]

B. Sys Admin [sys_admlIn]

C. Catalog Admin [catalog_admin]
D. Catalog Auinor (sn_cataiog_write]

Answer: C

NEW QUESTION 404
- (Topic 3)
Which feature can be used to categorize a set of records from a list and make them visible to other users?

A. Tags

B. History

C. Favorites

D. Activity Formatter
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Answer: A

Explanation:

Tags are labels that you can apply to any task record in ServiceNow. You can use tags to categorize, filter, and search records. You can also share tags with
other users to make them visible to others1.

ReferencesUsing tags

NEW QUESTION 409
- (Topic 3)
What does ServiceNow recommend as a best practice regarding data imports?

A. Adjust your Transform maps, after the data is loaded into the target table.

B. Use extremely large Import Sets, instead of multiple large Import Sets.

C. Create a new Import set table for each new data load.

D. Plan time before your import to remove obsolete or inaccurate data.

E. Monitor data quality and clean imported data, using the Data Scrub Workspace.

Answer: D

Explanation:

This is a best practice because it reduces the amount of data that needs to be imported, transformed, and stored in ServiceNow, and improves the data quality
and performance of the system1.

ReferencesIimport and export resources page

NEW QUESTION 412
- (Topic 3)
What access does a user need to be able to import anicies to a knowledge base?

A. Can contribute

B. sn_knowledge_contripute
C. sn_knowledge_import

D. Can import

Answer: A

NEW QUESTION 413
- (Topic 3)
When looking at a long list of records, you want to quickly filter, to show only those which have Category of Hardware. How might you do that?

A. On the list, locate and right click on the value Hardware, select Show Matching
B. Click Funnel ten, type Hardware and click enter

C. On the Category column header, right click and select Show > Hardware

D. Right dick on magnifier, type Hardware and click enter

E. On Breadcrumb, click > icon, type Hardware and click enter

Answer: A

NEW QUESTION 417
- (Topic 3)
One related list, which buttons are commonly used for managing the records on the list? Choose 3 answers

A. Publish
B. New
C. Ada
D. Manage
E. Edit

Answer: BCE

NEW QUESTION 418
- (Topic 3)
How would you navigate to the Schema map for a table?

A. System Dictionary > Show Schema Map; Select Table

B. System Definition > Tables; Select Table; Go to Related links and click Show Schema Map

C. System Definition > Show Schema Map; Select Table

D. System Definition > Dictionary: Select Table; Go to Related links and click Show Schema Map

Answer: B

NEW QUESTION 421

- (Topic 3)

What component causes a flow to run after a record has been created or updated?

A. Date-based trigger
B. Record-based trigger
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C. On-change trigger
D. Application-based trigger
E. Updated-date trigger

Answer: B

Explanation:

A record-based trigger is a component that causes a flow to run after a record has been created or updated in a specified tablel. It allows users to define
conditions and actions for the flow based on the record’s state and valuesl. For example, a record-based trigger can start a flow when a new incident is created or
when an existing incident is updated with a certain priority1.

References

? Flow trigger types - Product Documentation: San Diego - ServiceNow1

NEW QUESTION 424
- (Topic 3)
Which allows the creation of a task-based record from Service Catalog?

A. Record Producers
B. Ul Builder

C. Assignment Rule
D. Flow Designer

E. Ul Actions=

Answer: D

NEW QUESTION 426
- (Topic 3)
How would you distinguish between a Base Class table and a Parent Class table?

A. Base Class tables always have tables extended from them, Parent tables do not have tables extended from them.
B. Base Class table is not extended from another tabl

C. Parent class tables may be extended from another table.

D. Extended tables can be extended from Parent tables or Base tables, but they cannot be extended from both.

E. Extended tables are always extended from Parent tables, Extended tables are usually extended from Base tables,

Answer: B

NEW QUESTION 429
- (Topic 3)
On a filter condition, which component is always a choice list?

A. Operator

B. Filter Criteria
C. Operation

D. Match Criteria

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/common-ui-elements/concept/c_ConditionBuilder.html

NEW QUESTION 433

- (Topic 3)

The Report Designer contains different sections for configuring your report. Which section is used to adjust the look of your report, including colors, files, and
legend layout?

A. Format
B. Layout

C. Style

D. Configure

Answer: C

NEW QUESTION 436

- (Topic 3)

Which module would you use to customize your instances banner image, text and colors?
A Homepage Admin > Pages > Branding

A. System Ul > Ul Pages > Branding

B. System Properties > Branding

C. System Properties > Basic Configuration UI16

D. Service Portal > Portals > Branding

Answer: D

NEW QUESTION 438
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